
UF-490/525/590/790/890/990

Operating Instructions
Software

Model No.

English

Before operating this software, please read these instructions completely and keep these operating instructions for future reference.

(For Document Management System, Printer and Class 2 Fax Modem)

B
ef

or
e 

U
se

Pr
in

te
r S

ec
tio

n
Tr

ou
bl

es
ho

ot
in

g
C

la
ss

 2
 F

ax
 M

od
em

 
Se

ct
io

n
D

oc
um

en
t M

an
ag

em
en

t 
Sy

st
em

 S
ec

tio
n



2

The following trademarks and registered trademarks are used throughout this manual: 

Microsoft, MS-DOS, Windows and Windows NT are registered trademarks of Microsoft 
Corporation in the USA and other countries.
i386, i486 and Pentium are trademarks of Intel Corporation.
Centronics is a registered trademark of Centronics Data Computer Corporation.
TrueType is a registered trademark of Apple Computer, Inc.
All other trademarks identified herein are the property of their respective owners.

Copyright c 2003 by Panasonic Communications Co.,Ltd.
All rights reserved. Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.

Notification for UF-490/525/590/790/890/990

These models are designed with the Energy Conservation in mind, which will automatically 
goes into the Sleep mode when it is not in use for a period of time (The factory default is 1 
hour).

While the machine is in the Sleep mode, it will not wake up automatically by any print 
command from a connected computer. If you attempt to print a document from your computer 
to the machine while it is in the Sleep mode, an error message "LPT1 write error." will appears 
on your computer.

Please press the ENERGY SAVER key on the control panel of the machine before starting a 
print job from your computer.

If you wish to start printing at any time without having to press the ENERGY SAVER key to 
wake up the machine first, you can change the setting of the Fax Parameter #34 from "3" 
(SLEEP) to "2" (ENERGY-SAVER). This will stop the machine from switching into the Sleep 
mode.

Please refer to the machine’s Operating Instructions (For Facsimile) for details.
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Before Use

Precautions

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications.  However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by
one of the following measures:

1. Reorient or relocate the receiving antenna.
2. Relocate fax machine with respect to receiver or other equipment.
3. Connect fax machine into outlet on a circuit different from that to which the receiver is connected.
4. Consult the dealer or an experienced radio/TV technician for help.

Warning: To assure continued compliance, use only shielded interface cable when connecting the facsimile
machine parallel interface port to host computer. Also, any changes or modifications not expressly approved
by the party responsible for compliance could void the user's authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

• You need to read the software license agreement before setting up the Printer Driver.
• You need to read the following precautions which is described in the Fax machine Operating Instructions.

1. Installation
2. Ventilation
3. Handling
4. Toner and Paper
5. For your safety

For User in USA

Responsible Party: Matsushita Electric Corporation of America
One Panasonic Way, Secaucus, NJ 07094 

Technical Support: Panasonic Document Imaging Company/Technical Support Department
Two Panasonic Way, Secaucus, NJ 07094
1-800-225-5329
Email: consumerproducts@panasonic.com
5
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External View

External View

Parallel Interface Connector
  Connect to the PC

Parallel Interface Cable
  (A cable does not come with the unit.)  Use a cable of IEEE1284 

specifications, with a maximum length of 20 ft (6m).  Consult a 
service provider for details.

UF-490/525
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   Connect to the PC

Parallel Interface Cable
 (A cable does not come with the unit.)  Use a cable of 
IEEE1284 specifications, with a maximum length of 20 ft (6m).  
Consult a service provider for details.

UF-590/790
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External View
Parallel Interface Connector
  Connect to the PC

Parallel Interface Cable
  (A cable does not come with the unit.)  Use a cable of IEEE1284 

specifications, with a maximum length of 20 ft (6m).  Consult a 
service provider for details.

UF-890/990



Pr
in

te
r S

ec
tio

n

Printer Section

Installing the  Printer Driver 

Windows 98/Me/NT/2000/XP

1 Insert the Panasonic Document Management
System CD-ROM.

2 Select your desired language.

3 Click on the  button.

4 Click Printer Driver.
Note: The Fax Gateway and Firmware Update 

Utility is available for U.S.A. only.

Next

Continued on the next page...
9
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Windows 98/Me/NT/2000/XP
5 Click Install Printer Driver.

6 Select your machine's model(s) and click the

 button.

7 Click the  button if you would like

to change your current default printer to the
one that you are installing.

8 Select your new default printer from the New

Printer List and click the  button.

Next

Yes

Next
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The Panasonic/Panafax Printer Driver is installed, and the Panasonic/Panafax Printer icon(s) are added to
the Printer folder.

NOTE 1. When installing on Windows NT 4.0 and Windows 2000/XP, log onto the computer/network
with an account rights of Administrator.

9 The required files are copied.

10 When the setup process is completed, a
message is displayed prompting you to restart
your computer.

Click the  button to restart your

computer.

Finish
11
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Configuring the Printer Driver Settings

To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. Upon printing, changing the properties of Paper/Layout, Handling, Quality and Device
Options is allowed by clicking Properties in the print dialog box of an application.

2. Management tab of the color of property dialog box is not used for the UF-490/525/590/790/
890/990.

3. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.

Windows 98/Me

1 Click the Start button, point to Settings, and then click
Printers.

2 Right-click the desired printer icon in the printers folder,
and select Properties in the dropdown menu.

The printer properties dialog box appears.
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General Tab

1. Comment
Enter comments to describe the printer, if desired.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an already set-up user will
remain unchanged even if the comment is modified later.

2. Separator page
This feature is not available on your machine.

3.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Print Test Page
13
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Windows 98/Me

Details Tab

1. Print to the following port
Displays either the port to which the printer is connected or the path to the network printer.

To change the printing destination, either select the printing destination port from the list or enter the
network path here.

2. Print using the following driver
Displays the type of the printer driver. Specify the printer being used or a printer model which can be
emulated with the printer being used.

3.  /  button
Assigns a port to the network drive or cancels a port assigned to the network drive.

4. Timeout settings - Not selected
Specify the amount of time (in seconds) allowed to elapse before the printer becomes online. If the printer
is not online within this duration, an error message will be displayed.

5. Timeout settings - Transmission retry
Specify the amount of time (in seconds) allowed to elapse before the printer is ready for printing. If the
printer is not ready for printing within this duration, an error message will be displayed.

Increase this value if a timeout error occurs when printing a large document.

6.  /  button
Adds/deletes a new port or a new network path.

7.  button
Updates or modifies the printer driver.

8.  button
Specify the method of sending (spool) documents from the program to the printer.
• Spool Data Type

Capture Printer Port... End Capture...

Add Port... Delete Port...

New Driver...

Spool Settings...
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Select spool data type (EMF format or RAW format). Specifying RAW format results in longer time
before placing an application operational after printing on the application.

Note: Spooling by EMF format (metafile compression) may cause the following problems on some
application software.
1) Printing result is different from the screen display.
2) Printing requires excessive time.

• Enable bidirectional support
Be sure to check the check box for "Enable bidirectional support" when installing the status monitor
(See page 101). Otherwise, printing may not function properly.

9.  button
Modifies printer port settings.

Port Settings...
15
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Windows 98/Me

Sharing Tab

1. Not Shared/Shared As
Select whether to display or use this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified at this time will be displayed when other users view information about the
printer on the network.

3. Comment
You can enter comment regarding a shared printer (such as the type of printer and the location where it is
installed). When other users view information about the printer on the network, the comment specified
here will be displayed.

4. Password
Specify a password when other users will connect to this printer.
Leave the box blank in order not to use any password.

NOTE 1. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.



Configuring the Printer Driver Settings

Windows 98/Me

Pr
in

te
r S

ec
tio

n

Paper/Layout Tab 

1. Paper Size
Select a document size.

2. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

3. Orientation
Select the print orientation (Portrait/Landscape).

4. Copies (1-99)
Specify the number of copies to be printed. If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

5. Zoom (50-200)
Specify an enlargement or reduction percentage when printing documents. If enlargement/reduction can
be set within the application, indicate 100% here and specify the enlargement/reduction percentage in
the Print dialog box of the application.

6. N in 1
For printing two or more pages on one sheet, specify a printing method.

Layout is selected by combining with "Orientation”. Each layout is displayed with the icon.
• 2 in 1: Print 2 pages of documents zoomed out by 65 or 71% on one sheet.
• 4 in 1: Print 4 pages of documents zoomed out by 50% on one sheet.

7.  button
Return all items in Paper/Layout Tab to standard settings (default).

Restore Defaults
17
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Windows 98/Me

Handling Tab

1. Sorter
Select whether to Stack or Sort when printing multiple copies.

2. Output Order
Specify the output order (Ascending/Descending).

3.  button
Return all items in the Handling Tab to standard settings (default).

Restore Defaults
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Quality Tab

1. Halftone
Select method of expressing halftone. Select the setting according to the data to be printed and your
preference
• Normal: Select the halftoning method to be used. Select it according to the details of data and your

preference.
• Line Art:  Use when printing originals containing line drawings or text.

2. Resolution
Select the printer resolution (300dpi/600dpi).

3. Density
Adjust the printing density (Contrast and Brightness) as desired.

4.  button
Return all items in the Quality Tab to standard settings (default).

NOTE 1. dpi (dot per inch) means the number of dots contained in one inch.  The higher the value is, the
higher the resolution becomes. 

2. Printing in 600 dpi resolution on UF-890/990 requires an optional D-RAM Memory Card
installed in the machine.

Restore Defaults
19
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Windows 98/Me

Device Options Tab

1. Number of Paper Tray
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

2.  button
Displays the version information about the printer driver.

NOTE 1. Device Options Tab is specified in the printer properties.
2. The Number of Paper Tray setting is not available for UF-490/525.

About...
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows NT 4.0, setting the properties depends on the log-in account. This section
describes properties to be specified by an administrator (system manager).

2. See "Configuring the Printer Driver Settings (User)" for details of user properties.  (See page
29)

Windows NT 4.0 (Administrator)

1 Log onto the computer/network with an account rights of
Administrator.

2 Click the Start button, point to Settings, and then click
Printers.

3 Right-click the desired printer icon in the printers folder,
and select Properties in the dropdown menu.

The printer properties dialog box appears.
21
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Windows NT 4.0 (Administrator)

General Tab

1. Comment
Enter comments to describe the printer, if desired.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an already set-up user will
remain unchanged even if the comment is modified later.

2. Location
Specify the printer location.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5.  button
This feature is not available on your machine.

6.  button
Specify the processor to be used for printing (Print Processor) and the data type (Default Data type).

The processor and data type affect the manner in which the printer functions in Windows NT. Normally
they do not need to be modified. However, modification might be necessary when the printer is used with
a special application.

7.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

New Driver...

Separator Page...

Print Processor...

Print Test Page
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Ports Tab

1. Print to the following port(s)
Displays a list of available ports for printing (Port), their status (Description) and printers that are
connected to these ports (Printer).

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configures the selected port. In case of a parallel port, Transmission Retry should be specified.

4. Enable bidirectional support
On a printer, this setting enables reception of configuration data and status data from computer. Be sure
to check this checkbox when installing status monitor  (See page 101). Printing may be disabled without
checking on the checkbox.

5. Enable printer pooling
Printer spool allows outputting data from one logical printer to two or more printers. With printer spool
enabled, a transmitted printing job is output to the first printer that is available for printing.

NOTE 1. Specify the time (seconds) waiting for the printer to be ready for printing. If a printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port...

Configure Port...
23
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Windows NT 4.0 (Administrator)

Scheduling Tab

1. Available
Schedules the printer for operation. Specify operating hours when From-To is selected.

2. Priority
Sets printing priority. The slider allows the priority to be adjusted from 1 through 99.

3. Spool print documents... / Print directly to the printer
Specify how documents should be sent from the application to the printer.

4. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, and so on) do not match the printer settings.

5. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

6. Keep documents after they have printed
Holds documents in the print queue even after they have been printed. These documents can be printed
again directly from the queue regardless of the state the application is in.
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Sharing Tab

1. Not Shared/Shared
Select whether to display or use this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified at this time will be displayed when other users view information about the
printer on the network.

3. Alternate Drivers
Specify the operating systems of other computers that might share this printer.

NOTE 1. When sharing a printer on the network, the print driver is installed on one print server, other
computers will automatically copy and use that driver.

2. For this reason, the print server must be ready with printer drivers for all the operating systems
of all computers that will be sharing the printer.
25
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Windows NT 4.0 (Administrator)

Security Tab

1.  button
Set printer access privileges.

2.  button
Displays the persons who used this printer and how they used.

3.  button
Set the ownership of the printer.

NOTE 1. In order to utilize these features, you need to have selected Audit... from User Manager's
Policies and have enabled File and Object Access in the Audit Policy dialog box.

Permissions

Auditing

Ownership
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Device Option Tab

1. Number of Paper Tray
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

2. Halftone Setup
 button

Select the halftoning method to be used (halftones specific to the printer).
Select it according to the details of data and your preference.

• Halftone Pattern
Select the pixel size to be used for halftones.

The greater the value, the coarser the image would become. However, a larger value is suited to printing
in large areas.

The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However,
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

Halftone Setup...
27
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Windows NT 4.0 (Administrator)

• Pixel Diameter

Adjust the darkness of the print image. Manipulate the slider to specify the pixel size. You can select
between specifying the real size in inches or specifying in percentage relative to the printer resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

3.  button
Displays the version information about the printer driver.

NOTE 1. Device Option Tab specifies device-specific settings and settings of optional devices. Refer to
the operation manuals of the optional devices, or on-line manuals for settings items.

2. Settings specified in this section are saved as standard (default) settings of the printer.
3. The Number of Paper Tray setting is not available for UF-490/525.

About...
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows NT 4.0, setting properties depends on the log-in account. This section describes
properties to be specified by a user, upon executing a print operation on an application. See
"Configuring the Printer Driver Settings (Administrator)" for details of administrator properties.
(See page 21)

Windows NT 4.0 (User)

1 Select Print in the File menu of the application.

2 Click the  button in the Print dialog box. 

3 The dialog box for the printer properties appears. Click
the desired tabs of the dialog box and specify the
properties.

Properties...
29
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Windows NT 4.0 (User)

Main Tab

1. Paper Size
Select a document size.

2. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

3. Copies (1-99)
Specify the number of copies to be printed. If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

4. Zoom (50-200)
Specify custom zoom when printing a document by zooming in/out at a desired rate. If the zooming rate is
specifiable in an application, specify "100%" (same size) here. Specify a zooming rate in the print dialog
box of the application.

5. Orientation
Select the print orientation (Portrait/Landscape).

6. N in 1
For printing two or more pages on one sheet, specify a printing method.

Layout is selected by combining with "Orientation”. Each layout is displayed with the icon.
• 2 in 1: Print 2 pages of documents zoomed out by 65 or 71% on one sheet.
• 4 in 1: Print 4 pages of documents zoomed out by 50% on one sheet.

7.  button
Return all items in the Main Tab to standard settings (default).

Restore Defaults
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Handling Tab

1. Sorter
Select whether to Stack or Sort when printing multiple copies.

2. Output Order
Specify the output order (Ascending/Descending).

3.  button
Return all items in the Handling Tab to standard settings (default).

Restore Defaults
31
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Windows NT 4.0 (User)

Quality Tab

1. Resolution
Select the printer resolution (300dpi/600dpi).

2.  button

• Contrast
Adjust the contrast of print images.

• Brightness
Adjust the brightness of print images.

• Dark Picture
Select this option in order to print dark images brighter.

• Negative
Select this option in order to print images with black and white reversed.

Halftone Color Adjustment...
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• Input RGB Gamma
Adjust the gamma of print images (color intensities). Red, Green and Blue can also be adjusted
individually.

• Black Ref/White Ref
Adjust the difference between the darkest and lightest colors of an image. Increasing the Black Ref
value or decreasing the White Ref value will intensify the contrast of the image but reduces the range of
colors in between.

• Picture
Select a test pattern type.
Selecting the View check box will display halftone adjustment results in the test pattern.

3.  button
Return all items in the Quality Tab to standard settings (default).

NOTE 1. dpi (dot per inch) means the number of dots contained in one inch.  The higher the value is, the
higher the resolution becomes. 

2. Printing in 600 dpi resolution on UF-890/990 requires an optional D-RAM Memory Card
installed in the machine.

Restore Defaults
33
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows 2000/XP, setting the properties depends on the log-in accounts. This section
describes properties to be specified by an administrator (system manager). See "Configuring
the Printer Driver Settings" for details of user properties. (See page 43)

Windows 2000/XP (Administrator)

1 Log onto the computer/network with an account rights of
Administrator.

2 Click the Start button, point to Settings, and then click
Printers.

3 Right-click the desired printer icon in the printers folder,
and select Properties in the dropdown menu.

The printer properties dialog box appears.
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General Tab

1. Printer Name
Name of the printer specified upon installation is displayed.

2. Location and Comment
Enter a comment about the location of the printer installation and information about the printer.

If a printer is shared, the location and comment specified in this field appears when another user sets up
this printer on his/her computer. After completion of setup, however, changing this comment does not
update the location and comment appearing on users PCs.

3. Model
Model name of the printer is displayed.

4. Features
Functions and settings of the printer are displayed.

5.  button
Changes properties (print settings) specifiable for each user.
Refer to "Configuring the Printer Driver Settings" for details of settings  (See page 43)

6.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Printing Preferences...

Print Test Page
35
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Sharing Tab

1. Not Shared/Shared As
Specify if this printer is displayed or used on a computer of other users.

For sharing a printer, specify the share name of a printer to be shared. A name specified here appears
when other users view the printer information on a network

2.  button
Install additional printer drivers on the system.

When users running different versions of Windows share a printer, installing additional drivers avoids the
necessity for installing new drivers on their systems.

NOTE 1. If a printer is shared on a network, installing the printer driver on one print server allows other
computers to copy the driver automatically for use. Accordingly, a print server is required to
provide alternative printer drivers for other OS's that may use the printer.

Additional Drivers...
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Ports Tab

1. Print to the following port(s)
Displays a list of ports that allows printing, their status (description), and printers connected to the ports.

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configure the port that is selected. On a parallel port, wait time (in seconds) for retransmission is
specified.

4. Enable bidirectional support
On a printer, this setting enables reception of configuration data and status data from computer. Be sure
to check this checkbox when installing status monitor  (See page 101). Printing may be disabled without
checking on the checkbox.

5. Enable printer pooling
Printer spool allows outputting data from one logical printer to two or more printers. With printer spool
enabled, a transmitted printing job is output to the first printer that is available for printing.

NOTE 1. Specify the time (seconds) waiting for the printer to be ready for printing. If a printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port...

Configure Port...
37



Configuring the Printer Driver Settings

38

Windows 2000/XP (Administrator)

Advanced Tab

1. Always available/Available from
Specify the operation schedule for a printer. Selecting Available from allows specifying an operation time.

2. Priority
Specify the priority in printing. Priority is adjustable from 1 to 99. Document of higher priority are printed
before those of lower priority.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5. Spool print documents so program finishes printing faster
Specify the method of sending a document from the program to the printer.

6. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, and so on) do not match the printer settings.

7. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

8. Keep printed documents
After printing, documents are kept in the queue. The documents are allowed to be reprinted directly from
the queue regardless of the status of an application.

9. Enable advanced printing features
Enables advanced printing features. Optional features of the printer (page ordering, booklet printing,
numbering on sheets) are enabled. These features can be disabled if a problem occurs due to
incompatibility. Disabling the features may disable the printing options also.

New Driver...



Configuring the Printer Driver Settings

Windows 2000/XP (Administrator)

Pr
in

te
r S

ec
tio

n

10.  button
Specifies standard (default) values for the properties (print settings) specifiable for each user. If a local
printer is shared, the settings here are used as printing defaults for other users.

Refer to "Configuring the Printer Driver Settings" for detailed settings.  (See page 43)

11.  button
Specify a print processor and data type to be used for printing.

The processor and data type define operations of printers on Windows 2000/XP.

Usually no change is required in the settings. Use of a printer on a special application, however, may
require changes on the settings.

12.  button
This feature is not available on your machine.

Printing Defaults...

Print Processor...

Separator Page...
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Security Tab

Displays a list of users and groups that are assigned access to this printer. A list of standard access
permitted/prohibited for each group or user is displayed. Check the checkbox for permitting or prohibiting
access. Gray checkbox indicates inheritance of access permission.

1.  /  button
Add or delete a user or group in the list.

2.  button
Specify access to a printer, audit, and owner.

NOTE 1. Windows 2000/XP provides the capability of managing access to various objects (e.g. printers)
by users.

2. Refer to manuals of Windows 2000/XP for details of access permission, audit, and owner.

Add... Remove

Advanced...
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Device Options Tab

1. Number of Paper Tray
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

2.  button
Select the method of expressing device halftone (printer-specific halftone). Select the settings according
to printing data and preference.

• Halftone Pattern
Select the pixel size to be used for halftones.

The greater the value, the coarser the image would become. However, a larger value is suited to printing
in large areas.

The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However,
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

Halftone Setup...
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• Pixel Diameter

Adjust the darkness of the print image. Manipulate the slider to specify the pixel size. You can select
between specifying the real size in inches or specifying in percentage relative to the printer resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

3.  button
Displays the version information about the printer driver.

NOTE 1. Device Options Tab specifies device-specific settings and settings of optional devices. Refer
to operation manuals of the optional devices, or on-line manuals for settings items.

2. Settings specified in this section are saved as standard (default) settings of the printer.
3. The Number of Paper Tray setting is not available for UF-490/525.

About...
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows 2000/XP, setting the properties depends on the log-in accounts. This section
describes properties to be specified by a user, upon executing a print operation on an
application. See "Settings Printer Driver on Windows 2000/XP (Administrator)" for details of
administrator (system manager) properties.  (See page 34)

Windows 2000/XP (User)

1 Select Print in the File menu of the application.

2 Click the  button in the Print dialog box. 

3 The dialog box for the printer properties appears. Click
the desired tabs of the dialog box and specify the
properties.

Properties...
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Main Tab

1. Paper Size
Select a document size.

2. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

3. Copies (1-99)
Specify the number of copies to be printed. If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

4. Zoom (50-200)
Specify an enlargement or reduction percentage when printing documents. If enlargement/reduction can
be set within the application, indicate 100% here and specify the enlargement/reduction percentage in
the Print dialog box of the application.

5. Orientation
Select the print orientation (Portrait/Landscape).

6. N in 1
For printing two or more pages on one sheet, specify a printing method.

Layout is selected by combining with "Orientation." Each layout is displayed with an icon.
2 in 1: Print 2 pages of documents zoomed out by 65 or 71% on one sheet.
4 in 1: Print 4 pages of documents zoomed out by 50% on one sheet.

7.  button
Return all items in the Main Tab to standard settings (default).

Restore Defaults
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Handling Tab

1. Sorter
Select whether to Stack or Sort when printing multiple copies.

2. Output Order
Specify the output order (Ascending/Descending).

3.  button
Return all items in the Handling Tab to standard settings (default).

Restore Defaults
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Quality Tab

1. Resolution
Select the printer resolution (300dpi/600dpi).

2.  button

• Contrast
Adjust the contrast of print images.

• Brightness
Adjust the brightness of print images.

• Dark Picture
Select this option in order to print dark images brighter.

• Negative
Select this option in order to print images with black and white reversed.

Halftone Color Adjustment...
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• Input RGB Gamma
Adjust the gamma of print images (color intensities). Red, Green and Blue can also be adjusted
individually.

• Black Ref/White Ref
Adjust the difference between the darkest and lightest colors of an image. Increasing the Black Ref
value or decreasing the White Ref value will intensify the contrast of the image but reduces the range of
colors in between.

• Picture
Select a test pattern type.
Selecting the View check box will display halftone adjustment results in the test pattern.

3.  button
Return all items in the Quality Tab to standard settings (default).

NOTE 1. dpi (dot per inch) means the number of dots contained in one inch.  The higher the value is, the
higher the resolution becomes. 

2. Printing in 600 dpi resolution on UF-890/990 requires an optional D-RAM Memory Card
installed in the machine.

Restore Defaults
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Print Operation

If the printer driver is installed properly and a printer is selected as the default printer in the printer setup,
printing can be accomplished from any Windows application with simple operations.

To print from most Windows applications, use the Print... command on the File menu. Selecting the Print...
command typically displays the following Print dialog box:

After selecting the print range to be printed and the number of copies, click on  to start printing.

While documents are being printed, a printer icon appears on the System Tray near the clock on the bottom
right hand corner of the screen. The icon disappears when printing is completed.

NOTE 1. Follow the steps below to set a default printer:
1) Click the Start button and select Printers in the Settings menu.
2) Select the printer icon in the window and select [Set As Default] in dropdown menu by

right-clicking it. Then the check mark is displayed.

Printing from Windows Applications

OK
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For sharing a printer by connecting two computers via crossed-cable or using a hub, a connection among
computers must be established.

Establishing a connection among computers is verified by displaying the connected computers in Network
Neighborhood on the desktop.

The settings for printer sharing is specified by the following steps:

Printer server (PC connected to a printer)

Upon completion of the setting, the shape of the icon changes indicates it is shared.

NOTE 1. Refer to the manual of the network cards and Windows users guide for connection among
computers.

2. On Windows 98/Me, a computer connected to a printer must have been set up to allow printer
sharing by the following operations:
1) Double-click on the Network applet in the control panel folder, and then click on the

 button in the Network Configuration tab.
2) Check [I want to be able to allow others to print to my printer(s).] in the File and Print

Sharing dialog box.

Printing on Network

1 Install the printer driver on a computer to be connected to
the machine.

2 Click the Start button, point to Settings, and then click
Printers.

3 Right-click on the desired printer icon and select
[Sharing...] in the dropdown menu.

4 Select Shared As in the properties dialog box.

5 Click on the  button.OK

File and Print Sharing...
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Printing on Network

Client workstation (PC that uses other computer's printer).

The operations above enable output from the client workstaton to a printer connected to a printer server.

1 Click the Start button, point to Settings, and then click
Printers.

2 Double-click Add Printer in the printers folder.
Add Printer Wizard appears.
Click on the  button.

3 Select Network Printer.
Click on the  button.

4 Specify the other computer's printer by entering the
network path.

Then, complete the installation by following the instruction
of the Add Printer Wizard.

Next

Next
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Document Management System Section

Installing the Document Management System

Windows 98/Me/NT/2000/XP

1 Insert the Panasonic Document Management
System CD-ROM.

2 Select your desired language.

3 Click on the  button.

4 Click Panasonic-DMS.
Note: The Fax Gateway and Firmware Update 

Utility is available for U.S.A. only.

5 Click Install Panasonic-DMS Software.

Next

Continued on the next page...
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6 Verify the installation destination and click the

 button.

7 Verify the data folder destination and click the

 button.

8 Select your machine's model(s) and click the 

 (Add) button.  

Then, click the  button.

9 <Supported models only>

Select General User and click the 
button.

Note: If selecting Administrator, the network 
configuration editor and network address 
book editor will also be  installed on your 
PC.

Next

Next

Next

Next
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10 Click the Typical button.
Note: 1 The Panafax Desktop isn't installed 

depending on the model selected in the 
Typical Installation. If you wish to install 
the Panafax Desktop, select the Custom 
Installation and check the box of the 
Panafax Desktop

2 The   button is also indicated 
by the installation of Panafax Desktop of 

the Local version. Select   
when you wish to install it with the 
Server & Client system with the Client 
mode.

11 Enter the program folder name and click the

 button.

12 <Supported models only>

Click the  button if you want to

register the Panasonic Communications Utility
to start with Windows.

13 Click the  or  button.

14 The required files are copied.

Client

Client

Next

Yes

Yes No

Continued on the next page...
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When installing Panafax Desktop on Windows 98/NT, after rebooting your PC, the Microsoft Data Access
Components are automatically installed. Install it in accordance with the directions of the screen.

The Panasonic Document Management System folder is added to the Start menu, and the installation is
completed.

NOTE 1. When installing on Windows NT 4.0, log onto the computer with an account rights of
Administrator.

2. Before updating the software, be sure to remove the older version of software, using the
"Uninstall" shortcut from the Start Menu.

15 When the setup process is completed, a
message is displayed prompting you to restart
your computer.

Click the  button to restart your

computer.

Finish
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Document Manager

Document Manager is an application for managing documents (image files). By utilizing the Document
Manager and Document Viewer  (See page 78) in combination, a number of documents (image files) can be
classified, managed, browsed, and edited.

Selecting Panasonic → Panasonic Document Management System → Document Manager in Programs
of the Start menu displays the main window of the Document Manager.

1. Title Bar
Displays the title of a screen.

2. Menu Bar
Displays the menu of the Document Manager.

3. Tool Bar
Displays the tool buttons of the Document Manager. Tool buttons correspond to functions of the menus in
the menu bar.

4. Folder Window
Displays the folders containing the documents in tree form.

5. Link Icon
Dropping a dragged document onto a link icon, an application corresponding to the function of the icon is
activated.

6. Status Bar
Displays information such as the number of documents in a folder, the number of selected documents,
and file sizes, etc.

Main Window
55



Document Manager

56

Main Window

7. Document Window

Displays a list of documents in the selected folder.
Documents are displayed in thumbnails (reduced images). Page number and  and  buttons are
displayed at the bottom of a thumbnail image for grouped documents (configured with two or more
pages).

• Image data files
A thumbnail image of the document is displayed.

• Application data files
A thumbnail image of the document with it original application icon is displayed (i.e. Word, Excel and
PowerPoint).

Clicking on the < and > buttons turns the page on a multi-page document.
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The Document Manager allows editing and managing documents displayed in thumbnail images by
dragging and dropping. The function enables various operations as described below:

Basic Operations

• Selecting documents
Clicking thumbnail images in the document window allows
selection of documents. Dragging a mouse cursor on the
screen or clicking with the Shift key held down allows
selecting two or more documents at one time.

• Editing documents
Double-clicking thumbnail images in document window
activates Document Viewer  (See page 78), allowing opening
and editing documents.

• Creating Documents
Drag and dropping any application file into Document
Manager creates a new document. A thumbnail image file is
created and the application icon is displayed.
57
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Basic Operations

• Copying/Moving Documents

Dragging a thumbnail image in document window and
dropping it onto a folder in the folder window allows moving
the document to the folder. Dragging & dropping with the Ctrl
key held down copies a document.

Dragging a document and dropping it onto another document
in a document folder results in grouping the two documents
together.

Dragging a document and dropping onto a link icon activates
an application corresponding to the function of each icon.
Link icons are registered and deleted by selecting Launch to
Another Application → External Application Setup in the
File menu.

• Dragging a document and dropping it onto “Shared Folder”
allows other computers connected to the same network
access to it.
Browse “Shared Folder” for how to create shared folders.
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• Import document (from scanner)
Selecting Acquire Image... in the File menu displays a window for the Document Scanner  (See page 61).
The operation imports a document read on the scanner into a folder.

• Import document (from file)
Selecting Open in the File menu displays a dialog box for selecting files. The dialog box allows importing
image files saved in a computer as documents onto a folder.

An attempt of importing files that cannot be handled by Document Manager results in displaying an error
shown below. Press OK and verify a file format.

Dragging and dropping a selected document onto a link icon at the bottom of the window activates an
application specified for the link icon, and opens the image file.

The link icons can be Added/Removed freely by selecting Launch to Another Application → External
Application Setup in the File menu.

The following applications are specifiable as destinations of the Document Manager:

- Draw/Graphics software (Applications such as MS-Paint, Photoshop etc.)
- OCR software (Application such as e-Typist, etc.)
- PC-FAX software
- E-Mail software (MAPI-compatible mail application such as MS-Outlook, Netscape Messenger etc.)
- Others

(Other application documents such as MS-Word, MS-Excel etc.)

NOTE 1. Document Viewer provides a function to add various graphics and texts to an image.
The graphics and texts added to an image are called "Annotation." See "Annotation Menu"
(See page 91) for details of annotation.

Setting Plug-in
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File Menu

• New Folder
Create a new folder under a folder that is currently selected.
Path of a folder to be created can be specified as required.

• Shared Folder
Create a new shared folder. Documents in “shared folder “
can be shared through a network from different computers.

• Released Shared Folder
Released a shared folder. Documents in  “shared folder”  will
be released from a network.

• Open
A file saved in the computer and can be imported into a folder
as a document.

• Save As
A document is saved as an ordinary image file under a
specified name.

• Rename
Change the name of a document.
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NOTE 1. See "Document Scanner"  (See page 72) for operation of scanner.

• Properties
Display the file properties.

• Backup
Backs up the documents stored in the selected folder.

• Acquire Image...
Using a scanner, etc. selected in Select Source, import a
document to a folder that is currently selected.

• Select Source
Select a TWAIN-compatible device for scanning documents.
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File Menu
NOTE 1. Print Setup specifies printing or not printing annotations edited in the Document Viewer. See
"Annotation Menu"  (See page 91) for details of annotation.

• Print
Print a document selected in the document window.

• Print Setup
Specify layout and printing size for a document to be printed.

1. Horizontal Position and Vertical Position
Adjust the printing position on a sheet.

2. Print Size
Select printing in original size or printing in accordance with
the sheet size.

3. N in 1
Select for printing reduced pages on one sheet.
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NOTE 1. See "Setting Plug-in"  (See page 59) for specifying an external application.

• Launch to another application
Opens a document selected in the document window with a
specified application.

Selecting External Application Setup displays a dialog box for
adding/changing/deleting the application.

Clicking the Add button displays a dialog box to Add External
Application.

1. Name
If an external application is specified, the name in this field
appears on a link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file of an application.

4. MAPI Correspondence
Check here if the E-mail application is compatible with MAPI.

5. Parameter
If the E-mail application is incompatible with MAPI, adding a
parameter here allows automatic activation of a transmission
screen.
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File Menu
• Trash Can
- Open Trash Can

Opens the Trash Can and displays any files. Selecting

documents and clicking the  button restores
documents that have been discarded.

Click the  button to delete the selected
document.

- Empty Trash Can
Deletes the files in the Trash Can. If the documents are
emptied from the Trash Can, they are permanently deleted.
They are not stored in the Recycle Bin.

Undo

Delete
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NOTE 1. See "Annotation Menu"  (See page 91) for details of annotation.

Edit Menu

• Undo
Undo the last editing operation done.

• Cut
Delete a selected document from a folder and copy it to the
clipboard.

• Copy
Copy a selected document onto the clipboard.

• Paste
Paste a document from the clipboard onto a selected folder.

• Delete
Delete a selected document from a folder to the Trash Can.
A confirmation message for deletion appears.

• Select All
Select all documents in the folder.

• Find
Search for documents by specifying a document name,
creation date, or character string in the document.
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View Menu

• Tool Bar
Switch between displaying/hiding the tool bar.

• Status Bar
Switch between displaying/hiding the status bar.

• List Format/Thumbnail Format
Switch between list display and thumbnail display in the
document window.

• Arrange Folders
Sort the document folders by name or date.

• Arrange Document
Sort the documents in the current folder in the specified order
(Name, Type, Size or Date).

• Line Up Documents
Line up the documents in the document window.

• Refresh
Refreshes the contents of the Document  Manager.
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Document Menu

• Open
Open a selected document. Activates the Document Viewer
(See page 55) and opens a document for editing.

• Duplicate
Makes a copy of the selected document in a folder.

• Rotate
Rotate the selected document.
- Rotate Right
- Rotate 180 Degrees
- Rotate Left

• Group
Makes a group of two or more selected documents. The

grouped documents are indicated by page number and 

and  buttons at the bottom of a thumbnail image.

- Every Document
The selected documents are grouped.

- Every Page Alternately
Groups pages alternately.

- Every page reverse alternately
Groups pages alternately by reversing the pages.
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Document Menu

• Ungroup

Cancel the grouping for grouped documents. Either dividing
all pages into individual documents or releasing only specified
documents from a group can be selected.

• Enhancement
Apply the following correction to a selected document:

- Correct Skew
Detect any inclination of a document and automatically
correct it.

- Enhance Edge
Enhance edge (border) of image.

- Eliminate Noise
Remove noise on a document.

- Reverse Gradation
Display image in reverse.

• Page
Select pages to be displayed in thumbnail among grouped
documents.

Selecting Rearrange Page displays the page sorter dialog box.
The order of the pages are changed by selecting, dragging and
dropping the pages.
Click the Reverse Order button to reverse the page order.

• Attachment File
Open a dialog box to launch the application associated with
the selected attachment.

• File Conversion
Create image of the selected attachment.
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Image Converter

Once Panasonic-DMS has been installed, the Panasonic Document Manager (Image Converter) is
automatically installed in the Printers folder too.  This driver is for rasterizing application files such as Word
or Excel for placing them in the Document Manager.  To change the default properties,  follow the
instructions below:

1. Click the Start button, point to Settings and then click Printers.

2. Right-click on Panasonic Document Manager and select Properties from the dropdown menu.
The Properties dialog box appears.

3. Click on the  button to save the settings and close the Properties dialog box.

General Description

Windows 98/Me

• Paper/Layout tab

- Paper Size
Sets the document paper size

- Orientation
Sets the document orientation

- Resolution
Sets the document resolution

• Quality tab

- Color
Sets the color document conversion to color or monochrome

- Monochrome
Select Normal (Black and White) or Grayscale (Photo) when
converting to monochrome. Also sets the brightness and
contrast. 

OK
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1. Click the Start button, point to Settings and then click Printers.

2. Right-click on Panasonic Document Manager and select Document Defaults from the dropdown
menu. The Document Properties dialog box appears.

3. Click on the  button to return to the Printers folder.

Windows NT 4.0

• Page Setup Tab

- Paper Size
Sets the document paper size

- Orientation
Sets the document orientation

- Color Appearance
Sets the document to color or grayscale

• Advanced Tab

- Paper Size
Sets the document paper size

- Orientation
Sets the document orientation

- Resolution
Sets the document resolution

- Color Appearance
Sets the document to color or grayscale

OK
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1. Click the Start button, point to Settings and then click Printers.

2. Right-click on Panasonic Document Manager and select Printing Preferences from the dropdown
menu. The Printing Defaults dialog box appears.

3. Click on the  button to return to the Printers folder.

Windows 2000/XP

• Layout tab
Sets the document orientation.

• Paper/Quality tab
Sets the document to color or grayscale.

• Advanced button
Sets the paper size, resolution and spooling properties.

OK
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Document Scanner

Upon image scanning, an image is imported directly into a document using a TWAIN-compatible application
(image editing software, etc.).

Selecting Acquire Image... in the File menu displays for the Document Scanner dialog box.

Main Window

1. Preview Window
Displays images of a preview scan. The black frame represents the actual scanning area (Output Size). You may
adjust/select the final scanning area by resizing the black frame over the desired area of the image. The size of the
black frame is shown in the Output Size field.

2. Image Type
Select the type of image to be scanned.

• Monochrome image (no halftone correction)
A method suitable for an image containing mainly text and drawings. Select this type when halftone correction
results in a blurred image.

• Halftone image (error diffusion)
This method, using no uniform pattern in halftone, is suitable for natural images such as photographs and
produces smooth images. The method, although requiring somewhat large file sizes, produces high-quality
images in comparison to the dither method.

• Halftone image (4x4, 8x8 dot dither)
This method, which produces images with a unique uniform pattern, is suitable for photographs.

• Halftone image (4x4 Bayer's dither)
This method, with somewhat lower image quality, reduces file sizes.

• Grayscale image (256 scales)
This method, best suitable to natural images such as photographs, produces tones with high fidelity by no
halftone correction. Compared to halftone image scanning, this method requires longer scanning times and
results in larger file sizes.

3. Resolution

Select the resolution for scanning.
Note: The Standard, Fine and Super Fine resolution are types that is best suitable if you are to send the images

to an ordinary fax machine in the future.

4. Paper Size

Select the size of originals to be scanned. The size and orientation of the preview window changes according to
the selected document size.

5. Lock
Fixes the size of the scanning area (black border) in the preview window, disallowing changing the size.
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NOTE 1. The menu for operating the Document Scanner (scanner driver) depends on the application.
Refer to the manuals of the application for details.

2. If a TWAIN-compatible application has not been installed, select Document Scanner from the
Start menu.

6. Slice Level (valid only when monochrome is selected)
Specify the value of distinction between monochrome for monochrome manuscript. Adjust the value according to
density of a manuscript to be scanned.

7. Brightness (valid only when halftone or grayscale is selected)

Adjust the brightness for halftone or grayscale documents.

8. Contrast (valid only when halftone or grayscale is selected)
Adjust the contrast (difference between dark and light) for halftone or grayscale documents.

9. Invert
Scan the image in negative.

10. Edge Enhancement

Scan the image with a highlighted edge.

11. Output Size
Displays size of the scanning image and the size of the scanned file.
The output size is determined by the size of the scanning area (black frame) in the preview window and the
resolution.

12. Unit
Select the unit of measurement (mm, inch, or pixel).

13.  button

Scan an image into the document desktop.

14.  button

Perform preview scanning and display the image on the preview window.

15.  /  button

Zoom in/out for a preview-scan image.

Scan

Preview

Zoom In Zoom Out
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• Adjustment - Gamma Curve
Display a dialog box for adjusting the gamma (color strength characteristics) of an image. (valid only when
halftone or grayscale is selected)

Adjust the gamma curve by dragging the slide bar or entering a value.

Moving the slide bar in the + direction reduces the difference between the highlight (light portion) and
halftone. Moving the slide bar in the - direction reduces the difference between the shadow (dark portion)
and halftone. In either case, the halftone becomes less prominent.

Click the  button to apply the changes.

NOTE 1. Adjustment in the Tool menu becomes valid only if <Halftone> or <Grayscale> have been
selected in <Image Type> on the main window.

Tool Menu

Apply
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• Adjustment - Highlight and Shadow
Displays a dialog box for adjusting the highlight and shadow. (valid only when halftone or grayscale is
selected)

Adjust the highlight and shadow by dragging the slide bar or entering a value. Enhancing the highlight
(bright portion) and the shadow (dark portion) makes clear shades on an image.

Click the  button to apply the changes.

• Parameter Reset
Return all settings in the Document Scanner to standard settings (default).

Apply
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Image scanning is performed by the following procedures:

Image Scanning

1 Activate TWAIN-compatible application.

2 Select Acquire Image... in the File menu
to display Document Scanner.

3 Specify the image type, resolution, and
paper size of a document to be scanned.

4 Place a document on the ADF and click

the  button.
A preview-scanned image is displayed in
the preview window.

5 Apply the following adjustments on the
preview image:

• Drag the scanning frame (black frame)
on the preview window to specify the
scanning area. If an area has already
been selected, double-clicking with
Shift key held down selects the whole
image.

• Clicking  / 
button zooms in/out a preview-scan
image.

• Adjust the Slice Level, brightness, and
contrast (difference between dark and
light portions) as required.

Preview

UF-490

Zoom In Zoom Out

UF-490
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NOTE 1. Adjust parameters for an optimum scanning image, with the view on preview image.
Preview scanning can be repeated any number of times.

2. Image scanning is only possible by the PC that the device is connected to directly through the
parallel port.

6 Click the  button to scan an
image into the document desktop.

Scan
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Document Viewer

The Document Viewer is an application for editing documents (image files) to be managed with the
Document Manager  (See page 55). In addition to usual image editing, the program provides various editing
capabilities for documents with a wide selection of annotation functions.

Double-clicking on the document (thumbnail) in the Document Manager screen or selecting Open in the
Document menu displays the main window of the Document Viewer.

NOTE 1. The program is activated also by selecting Panasonic → Panasonic Document
Management System  → Document Viewer from Programs of the Start menu.

Main Window
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1. Title Bar
Displays the title of the screen and the name of the image file being displayed.

2. Menu Bar
Displays the menu of the Document Viewer.

3. Tool Bar
Displays the tool buttons of the Document Viewer. Tool buttons correspond to functions of the menus in
the menu bar.

4. Page List
Displays the pages of the documents as thumbnails (reduced image).

5. Size Bar
Adjusts the scaling of the display on the image window.

6. Link Icon
Dragging and dropping a document on a link icon activates the application corresponding to each icon.

7. Status Bar
Displays information such as image file name, image type, and size.

8. Image Window
Displays the image and annotations of the pages being selected.

9. Ruler
Displays the actual size of an image that is selected. The unit of measurement is switched by Ruler Unit
in the View menu.
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Basic Operations

• Selecting Page
Selecting a page by clicking in the page list displays an image
of the selected page on the image window.

Dragging and dropping a page in the page list can change the
order of the pages.

• Image Editing
The image displayed in the image window is edited with the
menu below:

- Edit menu 
Editing operations such as cutting, copying, pasting
annotations added to an image.

- Page - Adjust Page menu 
Image correction and color balance adjustment of the whole
page.

• Selecting Area
Dragging the mouse on the image window allows selection of
a specific area in an image. This function is used to save a
specified area or specifying an area for annotation.
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Document Viewer provides the functions for adding various graphics and text to an image. The graphics and
text added to an image are called <Annotation>.

The annotation function, unlike usual image editing applications, does not change an image itself but lays
graphics and texts onto an image. Annotations and the original image are displayed as one image.

Annotations are managed separately from image data. Therefore, the Document Viewer can switch
between displaying and hiding annotations.

If an image is edited with the Document Viewer, and is exported (sent) to another image editing application,
whether to attach the annotation to an image or not can be selected.

Annotation Function

Annotation Original image Annotation added
to the original image
81
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File Menu
• Open

Opens an image file saved in the computer.
Files of the following formats can be opened on the Document
Viewer.

- TIFF
Tagged-Image File Format (TIFF)

- JPEG 
Joint Photographic Experts Group (JPEG) format

- BMP 
Windows standard bitmap format

- PNG
Portable Network Graphics format

- DDM
Document Manager file format

• Save
Save a document being edited.

• Save As
A document is saved as an ordinary image file under a specified
name.

- All page(s)
Save all pages in the document.

- Select page
Save only the selected page.

- Specified area
Save only the portion specified in the image window.

Document Viewer saves a file in the following formats:

- TIFF
Tagged-Image File Format (TIFF)

- Multi-page TIFF
Multipages Tagged-Image File Format (TIFF)

- Internet Fax TIFF
Tagged-Image File Format (TIFF) with Internet Fax format

- JPEG 
Joint Photographic Experts Group (JPEG) format

- BMP 
Windows standard bitmap format

- PNG
Portable Network Graphics format

- PDF
Adobe Acrobat PDF format

- DDM
Document Manager file format
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NOTE 1. When saving a document with annotations, save the document in the Document Manager file
format (DDM). This format saves the annotations and image data separately (as objects) so
that they can be edited later. Although saving a document in another format allows further
editing, the annotations cannot be undone. They are merged into the File.

• Print
Prints a document under the editing operation. For a document
containing two or more pages, pages from-to can be specified
for printing.

• Print Setup
Specify the layout, printing size, and printing of annotations for a
document to be printed.

1. Vertical position and horizontal position
Adjust the printing position on a sheet.

2. Print Size
Select printing in original size or printing in accordance with
the sheet size.

3. N in 1 printing
Select for printing two or more reduced pages on one sheet.

• Acquire Image
Adds a new image to a document.  The application selected in
Select Source runs and a scan image is created.

• Select Source
Selects the source for the image added through Acquire Image.
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File Menu
NOTE 1. See "Setting Plug-in"  (See page 59) for specifying an external application.

• Launch to another application
Opens a document selected in the document window with a
specified application.

Selecting External Application Setup displays a dialog box for
adding/changing/deleting the application.

Clicking the Add button displays a dialog box to Add External
Application.

1. Name
If an external application is specified, the name in this field
appears on a link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file of an application.

4. MAPI Compliant
Check here if the E-mail application is compatible with
MAPI.

5. Parameter
If the E-mail application is incompatible with MAPI, adding
a parameter here allows automatic activation of a
transmission screen.
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• Trash Can
- Open Trash Can

Opens the Trash Can and displays any pages. Selecting page

and clicking the  button restores page that has
been discarded.

- Empty Trash Can
Deletes the pages in the Trash Can. If the page is emptied from
the Trash Can, it is permanently deleted. it is  not stored in the
Recycle Bin.

Undo
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Edit Menu

• Undo
Undo the last editing operation done.

• Cut
Delete a selected annotation from a folder and
copy it to the clipboard.

• Copy
Copy a selected annotation onto the clipboard.

• Paste
Paste an annotation from the clipboard onto a
selected page.

• Clear
Clear a selected annotation.

• Select All
Select all annotations onto a selected page.
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• Drag Mode
Changes from Drag Mode to Text edit mode.

• Zoom In
Zooms in an image.

• Zoom Out
Zooms out an image.

• Fits to Page Width
Fits the display to the page width.

• Fits to Page Height
Fits the display to the page height.

• Full Page
Fits the display to the page full size.

• Original Size
Returns the display to the original size.

• 25% - 200%
Shows the display at 25% - 200%

• Detailed Settings
Sets Detailed setting such as thumbnail or page image setting.

View Menu
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Page Menu

• Next
Display the next page.

• Previous
Display the previous page.

• Top
Display the top page.

• Last
Display the last page.

• Select
Display a specified page.

• Auto Paging
Turns the pages automatically.
- Move Forward

Automatically step through pages forwards.
- Move Backward

Automatically step through pages backwards.
- Stop

Stop automatic page advance.
- Set up 

Set automatic page advance.

• Move page
Moves pages to the desired position.
- Next page

Move the current page to be posterior to the next page.
- Previous page

Move the current page to be anterior to the previous page.
- Top page

Move the current page to be the top page.
- Last page

Move the current page to be the last page.
- Select page

Move the current page to the page you specified.

• Delete Page
Deletes the current page.

• Copy Page
Copy the current page.



Document Viewer

Page Menu

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

NOTE 1. Grayscale and color information of a grayscale or RGB color image is lost upon conversion into
a monochrome image. The lost information is not restorable.

2. Color information of a RGB color image is lost upon conversion into a grayscale image. The
lost information is not restorable.

• Add Page
Adds new pages to documents.

• Insert Page
Inserts a page at the current position.

• Replace Page
Replace the current page with a new one.

• Rotate Page
- Rotate Right

Rotate the page 90 degrees clockwise.
- Rotate 180 Degrees

Rotate the page 180 degrees
- Rotate Left

Rotate the page 90 degrees counterclockwise.

• Adjust Page
- Correct Skew

Adjusting orientation.
- Eliminate Noise

Eliminate the noise.
- Enhance Edge

Enhances the edge.
- Brightness/Contrast

Adjusts brightness or contrast.
- Hue/Chroma

Adjusts hue or chroma.
- Reverse Gradation

Reverse Gradation.
- Monochrome

Convert to Monochrome.
- Grayscale

Converting to Grayscale.
- RGB

Converting to RGB full color.
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Page Menu
• Copy Page to Clipboard
Copy the entire page selected onto the clipboard.

• Copy Select Area
Copy Select Area To Clipboard

• Select All Pages
Select All Pages.
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Annotation Menu

• Show Annotation
The check box on/off setting specifies whether to display an
annotation in the page list thumbnail.

• Set Annotation
Protect the annotation from re-editing.

• Annotation Order
- Change Order To Top
- Change Order To Last
- Change Order To Previous
- Change Order To Next

• Text
Creates a text annotation and paste it to a page.

• Line
Creates a line annotation and paste it to a page.

• Rectangle
Creates a rectangular annotation and paste it to a page.

• Ellipse
Creates an ellipse annotation and paste it to a page.

• White Block
Creates a white rectangular (solidly white-painted rectangle)
annotation and paste it to a page.

• Black Block
Creates a black rectangular (solidly black-painted rectangle)
annotation and paste it to a page.

• Marker
Create a marker annotation and paste it to a page.

• Label
Creates a label annotation and paste it to a page.

• Stamp
Creates a stamp annotation and paste it to a page.

• Date
Creates a date annotation and paste it to a page.

• Page No.
Creates a page number annotation and paste it to a page.
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Annotation Menu
NOTE 1. For specifying text font and colors, select the drawn text and select Properties in the
Annotation menu  (See page 91). The Text Format Setup dialog box can be displayed also by
selecting Properties in the pop-up menu, that appears by right-clicking on a drawn text.

2. For specifying the thickness and color of a line, select a drawn line and then select Properties
in the Annotation menu  (See page 91). Graphics Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
line.

• Header
Edits a header common to each page.

• Footer
Edits a footer common to each page.

• Edit Text
Sets a format of a text in a selected annotation.

• Properties
Display Properties for annotation.
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• Text
Creates a text annotation. Select text annotation in annotation
menu (or tool button), and drag the mouse in the image
window to specify the display position.
A dialog box for text setup will appear.
Enter the text to display, and then specify text color and font.

• Line
Creates a line annotation.
Select line annotation in the annotation menu (or tool button),
and drag the mouse in the image window to draw lines.

• Rectangle
Creates a rectangle annotation.
Select rectangle annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
rectangle.
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Annotation Menu
NOTE 1. For specifying the thickness and colors of the rectangle, select the drawn rectangle and select
Properties in the Annotation menu  (See page 91). The Graphic Format Setup dialog box can
be displayed also by selecting Properties in the pop-up menu, that appears by right-clicking
on a drawn figure.

2. For specifying the thickness and colors of the ellipse, select the drawn ellipse and select
Properties in the Annotation menu  (See page 91). The Graphic Format Setup dialog box can
be displayed also by selecting Properties in the pop-up menu, that appears by right-clicking
on a drawn figure.

• Ellipse
Creates an ellipse annotation.
Select the ellipse annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw an
ellipse.
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NOTE 1. For specifying lines and colors of solid white, select the drawn solid white rectangle and select
Properties in the Annotation menu  (See page 91). The Graphic Format Setup dialog box can
be displayed also by selecting Properties in the pop-up menu, that appears by right-clicking
on a drawn figure.

2. For specifying lines and colors of solid black, select the drawn solid black rectangle and select
Properties in Annotation menu  (See page 91). The Graphic Format Setup dialog box can be
displayed also by selecting Properties in the pop-up menu, that appears by right-clicking on a
drawn figure.

• White Block
Creates a white rectangle (solidly white-painted rectangle)
annotation.
Select the white annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
white rectangle.

• Black Block
Creates a black rectangle (solidly black-painted rectangle)
annotation.
Select the black annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
black rectangle.
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Annotation Menu
NOTE 1. For specifying the color of a marker, select the drawn marker and select Properties in the
Annotation menu  (See page 91). The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking

2. For specifying the color and font of a label, select the drawn label and select Properties in the
Annotation menu  (See page 91). The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
label.

• Marker
Creates a marker annotation.
Select the marker annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
marker.

• Label
Creates a label annotation.
Select the label annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw
label displays Text Format Setup dialog box.
Enter texts to display and specify text color and font.
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• Stamp
Creates a stamp annotation.
The stamp annotation pastes another image file like a stamp.
Select the stamp annotation in the annotation menu (or tool

button) and click the  button. Then  drag the
mouse in the image window to specify the area, displaying the
stamp dialog box.

Click the  button to specify an image from a file.

Clicking the  button allows selecting image files to
be used as a stamp.

OK

Browse

Add
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Annotation Menu
NOTE 1. For specifying the color or font of the date, select the drawn date and select Properties in the
Annotation menu  (See page 91). The Text Format Setup dialog box can be displayed also by
selecting Properties in the pop-up menu, that appears by right-clicking on a drawn figure.

• Date
Creates a date annotation.
Select the date annotation in the annotation menu (or tool
button), and drag the mouse in the image window to specify
the area, displaying the Properties dialog box.
Specify the format, color, and font of the date to be displayed.

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Date
Specify the date here. Selecting from the calendar or
entering the date is selectable for data entry.

6. Format
Specify the display format here.

7. Text Align
Specify the text alignment.
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• Page No.
Creates a page number annotation.
Select the page number annotation in the annotation menu
(or tool button), and drag the mouse in the image window to
specify the area. Double-click the Page No area to display the
text the settings dialog box.
Specify format, color, and font of the page number to be
displayed.

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Text Align
Specify the text alignment.

Opens the Graphics Format Setup Dialog box.
Click on the drawn figure and select Properties to change the
thickness and colors of the lines.

1. Line Width
Specify the thickness of the lines here.

2. Line Style
Specify the types of lines here

3. Line Color
Specify the color of the lines here.

4. Fill Color
Select the color for solid painting here.
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• Main Tool Bar
Show/hide main toolbar.

• Page Tool Bar
Show/hide page toolbar.

• Annotation Tool Bar
Show/hide page adjustment toolbar.

• Image Tool Bar
Show/hide page adjustment toolbar.

• Status Bar
Show/hide statusbar.

• Page List
Show/hide page list.

• Ruler
Show/hide ruler

• Plugin
Show/hide plug-in

Window Menu
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Status Monitor

The Status Monitor is a MFP utility that monitors and displays the current status of connected devices.
Upon activation of Windows, the icon of the status monitor appears on the System Tray.

The Status Monitor indicates the device status by icon lamp color as listed below.

NOTE

1.
If the power of the device is not turned on or the parallel cable is not connected when starting
Windows, the error message shown above appears.

Verify the power source and parallel cable and then press the button.
2. Connecting the device to a network server disables the status monitor.
3. UF-890/990 is not available with this feature.

Task Bar Display

Lamp color Status
Blue Device is operational under standby, printing, copying status.

Yellow Device inspection is required under initialization, paper supply, open cover,
paper jam, etc.

Red Need for toner cartridge replacement, or device failure.

Gray Device is in Engergy Saver (Sleep) Mode.

Status Monitor

Retry
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Right-clicking on the status monitor in the System Tray displays the dropdown menu as shown below:

1. About
Displays the version information about the status monitor.

2. Open Status Monitor
Displays details about the current status of the device.

3. Pop up when error occurs
Selects whether or not a pop-up error message box appears when an error occurs on the connected
device.

When selected, a check mark appears to the left of the item. To turn off the pop-up error message, select
the item again and the check mark disappears

< Example of a pop-up error message box >

4. Exit
Close the status monitor.

Task Bar Menu
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Right-clicking the status monitor icon in the Task Bar and selecting Open Status Monitor in the dropdown
menu displays a dialog box for the status monitor.

• Status Tab

1. Model
Displays the name and number of a connected device.

2. Device Status
Displays the current status of the device.
If two or more items have been detected, clicking  /  buttons allows viewing all items.

3. Control Panel Display
Displays information as appear on the panel of the device.
If two or more items have been detected, clicking  /  buttons allows viewing all items.

4. Details
Displays the current status of the device in details.
If two or more items have been detected, clicking  /  keys allows viewing all items.

5. Status
Displays the communication status between the status monitor and the device.

Display Status Details
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Display Status Details

• Configuration Tab

1. Model
Displays the name and number of a connected device.

2. Configuration
Display a list with the current device configuration (optional devices, etc.).

3. Status
Displays the communication status between the status monitor and the device.
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• Paper Tab

The tab displays the type, size, and if there is any paper loaded in the paper tray. A comment by the user
can be entered freely in the <Paper Type> field.

NOTE 1. Changing the types of loaded paper does not change the comment in <Paper Type> unless it
is rewritten by a user.
105



106
Configuration Editor

This utility allows you to edit the machine configuration through the Parallel Port connected between the PC
and the device.

Startup Windows, and select Panasonic → Panasonic Document Management System → MFP Utilities
→ Configuration Editor from the Programs in the Start menu to display the configuration editor dialog box.

Each setting category appears as a folder on the left frame and the setting item appears on the right frame.

Main Window

If the device is turned "Off" or not connected, a dialog box
appears as below. You may select.

• Retry 
After turned "On" the power or connected the device.

• Work Off-Line
Edit the data from an existing file.

• Exit
Exit the program.

When there is more than 1 supported model series installed,
a "Browse for Folder" dialog box appears as below.

• Select the model series folder and click OK.
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•  button
Retrieve the current settings of the selected folder from the device.

•  button
Write's the settings in the folder to the device.

•  button
Opens the settings in the folder from a file.

•  button
Saves the settings in the folder to a file.

•  and  buttons
Switch between pages if the settings have two or more pages.

•  button
Displays the help screen.

•  button
Displays version information.

•  button
Close the Configuration Edit utility. If the data has not been sent after being modified on the screen, a
confirmation message for sending the data is displayed.

NOTE 1. Only settings in the setting folder that are currently selected are applicable to retrieving/writing
on the device, or retrieving/writing of a file.

2. Current settings of each folder are read from the device by double-clicking a folder in the left of
the dialog box.

3. The setting menu's are different depending on the machine to be used with this MFP utility.
4. UF-890/990 is not available with this feature.

RetrieveRetrieve

Write

Open File

Save File

Help

About...

Exit
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Specify the originating party name and telephone number, etc. to be registered on the device for fax
communications.

User Parameters Folder
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Display or change the Fax Parameter Settings.

NOTE 1. The contents of the Fax Parameter differs depending on the model.

Fax Parameters Folder
109
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Display the Fax communication journal.

Journal Folder
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When the Phonebook Folder is selected the Phone Book Editor utility will be started.

Phone Book Setting Shortcut Activation Folder
111
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Phonebook Editor

This function allows registering, deleting, and modifying fax phone numbers in the main unit from a
connected PC.

Features provided by the Phonebook Editor function are as follows:

NOTE 1. UF-890/990 is not available with this feature.

Features

Registering, deleting, modifying
fax numbers can be operated on
the control panel of the machine.

The operation described on the
left is controllable on a connected
PC.

Retrieve/Write Retrieve fax numbers in main unit to the PC, or send fax
numbers from the PC to the main unit.

Page 116

Open/Save File Open or save fax numbers stored the PC. Page 117
Insert/Delete Entry Insert or delete lines in the fax number list. Page 119

Page 120

If the device is turned "Off" or not connected, a dialog
box appears as below. You may select.

• Retry 
After turned "On" the power or connected the
device.

• Work Off-Line
Edit the data from an existing file.

• Exit
Exit the program.

When there is more than 1 supported model series
installed, a "Browse for Folder" dialog box appears as
below.

• Select the model series folder and click OK.
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Take the following steps to activate the phonebook editor software.

Activation Procedure

 Click Start at the bottom left of the PC screen.

Select Programs.

Select Panasonic.

Select Panasonic Document Management       
System.
Select MFP Utilities.

Select Phone Book Editor.

Phone Book Editor splash screen appears and the 
Phone Book Editor program is activated.

Start

1

2

3

4

5

6

7
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The screen shown below appears on the PC:

Main Window

No. Indication Description Reference
Abbr. Dialing No. Tab Contains the abbreviated dialing number entries

One-Touch Tab Contains the One-Touch Key entries

About Version information of software

ABBR. NO. Abbreviated Dialing Number

Telephone No. Telephone number (Up to 36 digits)

Station Name Station name (Up to 15 characters)

Retrieve Retrieve phonebook information from the connected Page device. Page 116

Write Send phonebook information to main unit Page 116

Open File Read phonebook information in PC Page 117

Save File File Save phonebook information onto PC Page 117

Insert Entry Insert a line in the phonebook list Page 119

Delete Entry Delete a line in the directory dialing list Page 120

13 1415

1

2

3

4

5

6

7

8

9

10

11

12
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Help Display an on-line help screen

Exit Close the phonebook editor software

ONE-TOUCH One-Touch Key

No. Indication Description Reference

13

14

15
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This function retrieves the fax numbers in the connected device by PC and writes fax numbers from the PC
to main unit.

Retrieve/Write

1 Click Retrieve.

2 Click the  button.

3 A list of fax numbers in the machine is
displayed.

Modify and add destination names and dial
numbers on this screen.

4 Click Write after the editing is completed.

5 Click the  button.

The phonebook information is written to the
connected device.

Retrieve

Yes

Write

Yes
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This function opens the phonebook file in the PC, edits the file and then saves the file in the PC again.

Open/Save File

1 Click Open File

2 Click the  button.

3 The File Open dialog box appears
1. Select a file from the list (e.g. UF-790.pb)
2. Click the  button.

4 The phonebook information stored in the PC
is displayed.

Modify and add destination names and dial
numbers on this screen.

Open File

Yes

Open

Continued on the next page...
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Open/Save File
5 Click Save File after the editing is completed.

6 Click the  button.

The phonebook information is saved in the
PC.

7 For Save File:
1. Select an existing file from the list or

enter a new file name.

2. Click the  button.

Save File

Yes

Save
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This function adds lines in the list when editing the phonebook.
The steps for inserting lines is as follows:

Insert Entry

1 Ex: Insert a line between the 2nd and 3rd lines.
Click the portion indicated as .

2  Click Insert Entry.

A line is inserted as shown on the left.

3 Double-click on the line for data entry.

1

2

119
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The steps for deleting lines is as follows:

Delete Entry

1 Ex: Delete the 3rd line.
Click the portion indicated as .

2 Click Delete Entry.

The screen shown on the left appears.

Click  .

The line is deleted as shown on the left.

1

OK



D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

Panafax Desktop

Panafax Desktop is a PC Faxing application specifically designed to compliment the Panasonic line of
multi-function products

Document(s) created on the PC can be easily faxed to a remote location directly, without having to print a
hard copy first and then using the fax machine to send. This improves the copy quality received at the
remote location, saving the cost and time of printing the hard copy locally before faxing it.

Compatible Models

 Network Connected Models

 Group 1
- DX-600 / 800
- DP-3510 / 4510 / 6010 with Fax and I-Fax Options
- DP-2310/3010 with Fax and I-Fax Options

 Group 2
- DX-1000/2000
- DP-1810F with I-Fax Option
- DP-2000/2500/3000 with Fax and I-Fax Options

 Local Connected Models
- UF-490/525 (Standalone System only)
- UF-590/790
- UF-890/990 (Tx only)
- DP-1810F

Restriction(s)

Common
- The size of the data that can be transmitted is limited to the size that is within the memory of the

device. The transmission is canceled when the device’s memory overflows during the transfer of the
fax data. 

- The maximum number of multi-station transmissions is up to 999.

Network Connected Models Only
- The total number of direct dialing stations of the device limits the total number of stations that a fax

message can be transmitted to. The transmission is canceled when it exceeds that number during the
data transfer to the device from the PC.

- For Simple Send Only System with Group 2 Device(s), the fax data is transferred to the device
continuously without confirmation of the job. The transmission is canceled when it exceeds the
maximum number of stations, number of jobs or memory size of the device during data transfer to the
device from the PC. 

- For Simple Send Only System or Send and Receive System with Group 1 Device(s), the fax data
is transferred individually from the Panafax Desktop while obtaining the completion confirmation for
each job, by means of the Job Completion Notice (Send Only) or Communication Journal (Send and
Receive).  

If you are running Anti-virus Software, it may interfere and/or cause the Panafax Desktop from sending
a PC Fax Job to the Device properly. You may be required to disable the Anti-virus software when
using the Panafax Desktop temporarily. Please consult your Network Administrator.

General Description
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For the Network Connected Models
There are two types of Panafax Desktop configurations, Simple Send Only System and Send & Receive
Network Shared System.

Note:
*1: The result of the Simple Send Only System transmission with Group 2 Device models (refer to the list of

compatible models in the previous section), the Send Log and TX Confirmation Notice confirms the
transfer to the device only. The only way to confirm whether it reached the final destination is with a
transaction journal of the device. (Pages sent column is 0)

 
*2: The result of the Simple Send Only System and Send and Receive System transmission with Group 1

Device models and all other compatible models, is reflected in the Send Log and TX Confirmation
Notice. (Actual Pages Sent)

Simple Send Only System Connection Diagram

Connection Configurations (For the Network Connected Models)

Device Setting PC Fax Setting

Simple Send Only System
• Peer To Peer Connection
• Email Server Not Required

• IP Address settings
• Relay XMT Password setting
• Relay XMT Report = Off setting*1

• Relay XMT Password setting

Send & Receive Network  
• Shared Network Connection
• Email Server and RX Email 

Account Required

• IP Address settings
• Relay XMT Password setting
• Relay XMT Report = Always setting*2
• I-Fax setting
• Fax Forward setting

• For the Server PC
- Email Address settings
- Relay XMT Password setting
- Server setting
- POP Receive setting
- For the Client PC
- Search Shared Server setting

aaa bbb
aaa bbb

Transfer Fax Data

Transmit

Send FAX
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Send & Receive Shared Network System Connection Diagram

aaa cccbbb

ddd

aaa

ddd

bbb

ddd

Transfer Fax Data Transfer
Fax Data

View Shared Folder POP Receive

Transmit

Receive

Send FAX

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Receive FAX

Fax Forward

LAN

LAN

ccc

ddd

Email
Server

Email
Server
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For the Local Connected Models
There are two types of Panafax Desktop configurations, the Standalone System and the Network Shared
System.

Standalone System

Connection Configurations (For the Local Connected Models)

Device setting PC Fax Setting
Standalone System
- Standalone Connection

- PC-FAX RCV MODE =   Print / Upload & Print / Upload - None

Network Shared System
- Shared Network Connection

- PC-FAX RCV MODE =   Print / Upload & Print / Upload For the Server PC
- Server Setting
For the Client PC
- Search Shared Server setting

aaaaaa

Transfer Fax
Data

Send
Parallel cable

dddddd

Transfer Fax
Data

Receive
Parallel cable
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Network Shared System

aaa cccbbb

ddd

aaa

ddd

bbb

ddd

Transfer Fax Data

View Shared Folder

Transmit

Receive

Send FAX

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Parallel cable

Parallel cable

Download
Fax data

Upload
Fax data

Receive FAX

LAN

LAN

ccc

ddd
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For the Network Connected Models
Panafax Desktop uses the fax modem in the Panasonic/Panafax models connected on your network (LAN)
for fax communication. 
Before using the Panafax Desktop, it is necessary to activate the Fax Modem and to setup certain
parameters. Follow the steps below to setup the Panafax Desktop.

Installation

Installation and Setup (For the Network Connected Models)

1 Confirm the following device settings. 

Send Only System settings:
Connection to the network
Set Internet parameters:

- IP Address
- Subnet Mask
- Default Gateway IP Address

Set Fax Parameters:
- Set the Relay XMT Report = off (Fax Parameter No. 143)

Send & Receive System settings:
Connection to the network
Set Internet parameters:

- IP Address
- Subnet Mask
- Default Gateway IP Address
- Email Address
- Email Server Name/IP Address

Set Fax Parameters:
- Set the Relay XMT Report = Always (Fax Parameter No. 143)
- Set the Fax Forward to Receive Email Account (Fax Parameter No. 054)

2 Install the Document Management System.
Refer to the Installation section of this Operating Instruction.

Note: 
For the DP-1810F/DP-1810F (Network PC Fax) DP-2000/2310/2500/3000/3010/4510/6010, the Panafax Desktop
does not install automatically with the TYPICAL installation. Select CUSTOM installation and check the Panafax
Desktop to be installed.
There is both a Parallel connection and Network connection Panafax Desktop for the DP-1810F. The model name
of DP-1810F (Network PC Fax) is selected when using the  Network version of Panafax Desktop and DP-1810F is
selected when using the Local (Parallel) version of Panafax Desktop.
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Basic Setup (Send Only System /Send & Receive System)

1 Double-click the  icon on the Windows Desktop.

The Panasonic Communications Utility appears.

Click the  button.

2 Device Search Ranges appears.

Click the  button to start searching for the 
Network Connected Devices.

Note: 1 It searches for all the devices within 
the default Subnet. Refine the 
search range when there are many 
devices connected in the Subnet, or 
you want to connect to devices 
outside of the Subnet. To change 

the search range, click  
button and specify the range.

OK

Search Now

Add

Continued on the next page...
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Installation and Setup (For the Network Connected Models)
3 Starts searching for the PC Fax devices on the network.

4 The Network connected PC Fax device(s) are listed in the 
PC Fax Device Locator.
Select the desired Device and double-click or Click on 
Properties from the Device menu.
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5 The PC Fax Properties appears.
<General> Tab
Input the PC Fax Settings.
Send Only System:

• Device's Email Address
This Setting is unnecessary.

• Device’s Relay XMT Password
The Relay XMT Password of the device.

• Result Report Email Address
This Setting is unnecessary. (See Note 1 and 3)

Send & Receive System:
• Device's Email Address

Set the Email Address of the device. (See Note 2)
• Device's Relay XMT Password

The Relay XMT Password of the device.
• Result Report Email Address

Set the POP Email Address for the reception. (See Note 3)
Note: 1. If you have your own Email Address and your

device is set up to Internet Fax , set your Email
Address here. You can receive the Result Report
from the device. In that case, set the Relay XMT
Report = Always (Fax Parameter No. 143).

2.Only the Email forwarded to the receiving
account from this Email Address will be received.
Input it precisely, otherwise it will not receive if
the Email address doesn't match.

3.When the Relay Domain is set in the User
Parameters of the device, it is required to be the
within the same domain (The right part of @) of
the Email address for the Result Report Email
Address. If it doesn't correspond, transmission
from the Panafax Desktop is rejected. 

<Transmission/Reception> Tab
• Transmission Setting

- Transmission Priority
If there are multiple devices available, you can set the 
transmit priority of the device.

- Dept counter mode On
When the Department Code function is being used at the 
device, check the box and input the Identification Code

- Start Status Monitor at sending
Starts Status Monitor automatically at sending. 
The condition of the device can be monitored. 
The Device Group 2 doesn't have this function.

• Reception Setting (Send & Receive System only)
- Makes Reception Effective

Check this box if you want to enable reception with this 
device.

• Acquires Phone Book data from the device
- Device's Password

Device's Password to acquire the phone book data from 
the device, it is required to set the same password as the 
Password of the device. 

Note:
1. The DX-600/800 uses the Remote Password.The 

DP-2310/3010/3510/4510/6010 uses the Key 
Operator Password.

2. The Device Group 2 doesn't have this function.

Click on  when you finish inputting the settings.OK

Continued on the next page...
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Installation and Setup (For the Network Connected Models)
Receive Setup (Send & Receive System only)

6 Confirm that the device's Condition is in Standby (It takes 
a little while) using the PC Fax Device Locator.

Click  or select Device | Exit from the menu to close 
the PC Fax Device Locator.
For the Send Only System, the setup is completed.
For the Send & Receive System, continue to the 
Receive Setup on the next section. 

1 Click  icon on the Windows Desktop.

The Panafax Desktop appears.
Select Tools | PC Fax Device Locator from the main 
menu.

2 The PC Fax Device Locator appears.
Select Device | Detail Settings from the menu.

x
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3 The Detail Settings appears.
• Fax Log Data Folder

- Location
Specify the location to save the Fax log data. The 
default setting is generally acceptable.

• Shared Server Settings
- The Shared and Account Name 

Set up when Panafax Desktop is used in shared 
mode.

• POP Server Settings for PC Fax Reception
This is set up when Panafax Desktop uses the 
Receive function.
POP Server settings and the receiving Email 
Account.

• PC Fax Transmit Setting
- Max. number of Multi-Station TX

Setup the maximum number of destinations    to 
transmit to during one transmit request to    a 
device. 
If the number of the destinations exceed this 
number, it will be divided into more than one 
transmission. When it is divided into several 
transmissions, and there are other devices 
available, it will transmit a request to multiple 
devices.

Click on  when you finish inputting the 

settings.
Note: 1. If your PC is running Windows NT/2000/XP

and the client PC is running Windows 98/Me,
it is necessary to use the Guest Account to
use the Fax Server function. If a message
comes up "Do you want to use the Guest
Account?" click [Yes] to use the Guest
Account.

2.When the Guest Account is made effective, a
security problem may occur.

-It will be possible to access common
folders even if there is no account in
Windows

-The possibility that a computer virus could
enter through this account.

Please set it after you confer with the Network
Administrator.

4 Select the desired Device and double-click or Click on 
Properties from the Device menu.

OK

Continued on the next page...
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Installation and Setup (For the Network Connected Models)
5 The PC Fax Properties appears.
Click Transmission/Reception tab and check the 
"Makes Reception Effective" box.

Click .

6 Confirm that the Reception status displays "Yes". It 
takes a moment.

Click  or select Device | Exit from the menu to
close the PC Fax Device Locator.

The Send & Receive System setup is completed.

OK

x
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Client Setup (Send & Receive System)

1 Click  icon on the Windows Desktop.

The Panasonic Communications Utility appears.

Click the  button.

2 Device Search Ranges appears.
Click on the [Shared Network Connected 
Device(s)] radio button.

Click the  to start searching the shared 
Server.

Note: Searching  sometimes may take a long time 
when there are many PCs connected to your 
network. In this case, we recommend  to click 
[Add] button and specify the Domain or 
Workgroup, or specify the Computer Name 
directory to reduce the searching time.

Look in
• Specified Domain or Workgroup

Input device's Domain or Workgroup.
• Specified Computer Name

Input the Server Computer Name.
• Shared Name

Input the Server Shared Name if you changed 
from the default setting.

• Password
Input the Server Password if you changed from 
the default setting.

OK

Search Now

Continued on the next page...
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Installation and Setup (For the Network Connected Models)
3 Start searching the Server for Network connected 
Devices.

4 The Network connected device via Server is listed in 
the PC Fax Device Locator.

Click  or select Device | Exit from the menu to
close the PC Fax Device Locator.

The PC Fax (Shared Device) Properties appears.
Click Transmission/Reception tab and checkout a 
box of "Makes Reception Effective".

Click .

Note: The reception function is shown as "Yes" if the 
shared device's reception function is effective. If 
you do not wish to receive faxes, select the 
Device and double-click or Click Device | 
Properties from the menu.The PC Fax (Shared 
Device) Properties appears.Click 
Transmission/Reception  tab and checkout the 
box for "Makes Reception Effective". Click 

x

OK

OK
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For the Local Connected Models
Panafax Desktop uses the fax modem in the Panasonic/Panafax models connected with your computer by
parallel cable. 
Before using the Panafax Desktop, it is necessary to activate the Fax Modem and to setup certain
parameters. Follow the steps below to setup the Panafax Desktop.
Installation 

Installation and Setup (For the Local Connected Models)

1 Confirm the following settings of the device. 
If you wish to receive change the following parameter
as “Upload & Print” or “Upload”.
PC-FAX RCV MODE = Print / Upload & Print / Upload
(Fax parameter No. 063)

2

or

Install the Document Management System.Refer to
the Installation section of these Operating Instructions.

Note: 1.For the DP-1810F/DP-1810F (Network
PC Fax) DP-2000/2310/2500/3000/
3010/4510/6010, the Panafax Desktop
does not install automatically with the
TYPICAL installation. Select CUSTOM
installation and check the            Panafax
Desktop to be installed.
There is both a Parallel connection and
Network connection Panafax Desktop
for the DP-1810F. The model name of
DP-1810F (Network PC Fax) is selected
when using the Network version of
Panafax Desktop and DP-1810F is
selected when using the Local (Parallel)
version of Panafax Desktop.

2.For the Network Shared System, select

 on the Select Setup Type
screen during the installation.

Client
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Installation and Setup (For the Local Connected Models)

Setup for Standalone System 

Special settings are unnecessary. It will be ready to send and receive fax massages if the device and PC
are connected with the parallel cable and Panafax Desktop is started. 
Note: Confirm that the device is not in the Energy Server Mode or Sleep Mode when you start Panafax
Desktop.

Setup for Network Shared System
Server PC

Server Setup (Network Shared System)

1 Click  icon on the Windows Desktop.

The Panafax Desktop window appears.
Select Tools | PC Fax Device Locator from the main
menu.

2 The PC Fax Device Locator appears.
Select Device | Detail Settings from the menu.

3 The Detail Settings window appears.
Check the box for the “Shared Server Setting”.

Click on  when you finish the settings.

• Fax Log Data Folder
Location
Specify the location to save the Fax log data. 
The default setting is usually all right.

• Shared Folder Settings
This is set up when Panafax Desktop is to be
shared.

OK
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Client PC
Client Setup (Network Shared System)

1 Double-click the  icon on the Windows Desktop.

The Panasonic Communications Utility window
appears.

Click the  button.

2 Device Search Ranges appears.

Click the  to start searching the shared
Server.

Note: 1.Note:Searching sometimes may take a long
time when there are many PCs connected to
your network. In this case, we recommend

you to click  button and specify
the Domain or Workgroup, or specify the
Computer Name directory to reduce the
searching time.

• Look in
- Specified Domain or Workgroup

Input the device’s Domain or Workgroup.
- Specified Computer Name

Input the Server Computer Name.
- Shared Name

Input the Server Shared Name if you changed
from the default setting.

• Password
Input the Server Password if it was changed from
the default setting.

OK

Search Now

Add

Continued on the next page...
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Installation and Setup (For the Local Connected Models)
3 Start searching the Server for Local connected
Devices.

4 The Local connected devices via Server is listed in the
PC Fax Device Locator.

Click  or select Device | Exit from the menu to 
close the PC Fax Device Locator.

5 Note: The reception function is shown as "Yes" if the 
shared device's reception function is effective. If 
you do not wish to receive faxes, select the 
Device and double-click or Click Device | 
Properties from the menu.The PC Fax (Shared 
Device) Properties appears.Click Transmission/
Reception tab and checkout a box of "Makes 

Reception Effective". Click .

x

OK
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Sending a Document via Windows Application
You can send a fax directly from any Windows Application by simply printing to the Panafax Desktop Driver.
For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedure below.

Sending Document

1 From the current Application select Print from the File 
menu.

2 The Print dialog box appears.

Select Panafax Desktop Driver from the Printer Name 
menu.

Click the  button to convert the document 

into a Fax image.

3 Enter the recipient's Fax No., Name and Company or 
select your Personal Phone Book.

Click the  button to enter the recipient to the recipient 
list.
Enter/select another recipient if you desire.

Type the Subject in the Subject field and a brief message
to be included in the Cover Sheet.

Click on the button when ready to send the fax.

Note: To input a pause, use the comma (,). 

4 Click on the  button to start the transmission.

OK

OK

Continued on the next page...
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Sending Document

Sending a Document via the Panafax Desktop

You can send a fax directly from a file made in any Windows Application by simply attaching the file via the
Panafax Desktop.
For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedure below.

1 Click  icon on the Windows Desktop.

The Panafax Desktop window appears.

Click on the  button to select a file for the 

transmission.

2 Select the file and click the  button to 

convert the document into a Fax image.

3 From the Panafax Desktop window, enter the 
recipient's Fax No. , Name and Company or select 
from your Personal Phone Book.

Click the  button to enter the recipient to the 
recipient list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief 
message to be included in the Cover Sheet.

Click on  the  button when ready to send the fax.

Note: To input a pause, use the comma (,).

4 Click on  the  button to start the 

transmission.

Open

OK
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Sending a fax memo by Panafax Desktop
You can send a fax memo directly from the Panafax Desktop. This memo can be sent quickly and easily.

1 Click  icon on the Windows Desktop.

The Panafax Desktop window appears.

2 From the Panafax Desktop window, enter the 
recipient's Fax No. , Name and Company or select 
from your Personal Phone Book.

Click the  button to enter the recipient to the 
recipient list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief 
message to be included in the Cover Sheet.
If you wish, click Cover Sheet to change the Cover 
Sheet Type.

Note: To input a pause, use the comma (,).

3 Click on  the  button to start the 

transmission.

OK
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Receive Setting

Receiving Document

1 Confirm the Panasonic Communications Utility icon is 
in the taskbar tray.

2 Right-click the Panasonic Communications Utility Icon 
to show the menu and select the PC-Fax Reception 
Notification.

• Popup Display
• Icon Display
• No Notice

When a fax is received on the machine, it will proceed as follows:

1 A receiving notice appears on the connected PC.

Click the  button.

or

The Panasonic Communications Utility icon is 
changed. 
Double click the icon.

2 The Receive Log appears.
Select a transaction from the log then click the  

 button to view the received fax.

3 The received fax is displayed on the PC.

Receiving LOG
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Registering the Personal Phone Book
To register a recipient to the Personal Phone Book, follow the steps below:

1 Click on the  button to open the Phone Book 

dialog Box.

2 Click on the  button.

3 <Contact> Tab
• Name:

Enter the recipient's name.
• Fax No.:

Enter the fax number.
• Call Type:

Select how the call should be dialed.
The code set up with Tools/Configuration/Dialing 
Settings is dialed at the head of the fax number.

Note: To input a pause, use the comma (,).

4 <Data Fields> Tab
Enter the Company Name, Department, Job Title, 
Address, Direct Phone No. and the Extension Phone 
No. of the recipient to be used on the Cover Sheet.

5 Click the  button to save the entry.

The maximum number entries is 2000.
To add another entry, repeat from the step 2.

OK
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Registering the Personal Phone Book

To register a group of recipients, follow the steps below:

1 Click the  button.

2 The Phone Book dialog box appears.

Click the   button.

3 The Group Registration dialog box appears.

Click the  button.

4 The Add New Group Name dialog box appears.

Enter the group name and click  button.OK
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5 Select the desired recipients.

6 Click the  button to add the recipient(s) to 

the Member List.
The maximum number of recipients is 999 for each
group.
To add another group, repeat from step 3.
The maximum number of group's is 100.

If finished, click  button to exit Group

registration.

To register a group of recipients, follow the steps below:

OK
145



Panafax Desktop

146

Registering the Personal Phone Book

To Import/Export CSV data From/To your Personal Phone Book
The telephone data of CSV format file can be imported into your Personal Phone Book and telephone data
of your Personal Phone Book can be exported to a CSV file. 
Note: 
1. The "CSV file" means "Comma Separated Value" format file.
2. Though a pause usually is indicated as a comma (,) with Panafax Desktop, it is changed into "p" by the

import and Export of the CSV file. Please input pause with "p" when you make a CSV file.
Import from the CSV file

1 On the Phone Book dialog box,Select File | Import...
from the menu.

2 Select the file to be imported and click .

3 Confirm the contents of the Data Field and
Addressbook Field match.
Check off the item box if you do not want to import it.

Select the item and click  to
change the field setting if the Data Field and
Addressbook Field doesn't mach.

Click  if you completed.

4 The telephone data of CSV file is imported into your
Phone Book.

Open

Change Mapping...

OK
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Export to the CSV file

1 On the Phone Book dialog box,Select File | Export...
from the menu.

2 Enter the file name and click  to save the

CSV file.

OK
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The Cover Sheet is attached to the first page of every fax and contains information such as the recipient's
name, sender's name, date, title, etc.

Creating Cover Sheet

Cover Sheet

1 Click the  button.

2 The Cover Sheet Editor window appears. 
Edit the Cover Sheet.
Select Save As from the File menu.

3 The Save as dialog box appears.
Select the Folder you wish to save it to,  or
if you wish to save it into  the New Folder,

click  button,
enter the New Folder Name,

and then click .OK
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4 Enter the New Folder Name into the Cover Sheet File 
Name box.
Enter any comments into  the Comment box if you 
want.

Click  button to save the New Cover 

Sheet.

[Edit] menu
Page Size : Sets the size of the cover sheet.

Date Frame : Inserts a date field.

Text Frame : Inserts a text box.

Line/Box : Inserts a line or box.

Image Frame : Inserts an existing image file (bmp file).

Recipient Details :
Inserts the information set in the  and  tabs on the Personal Address
Book.

Sender Details : Inserts the information set in the  tab on the Tools menu.

Comments : Inserts a comment field for typing a brief message when sending a fax.

Subject : Inserts a subject field when sending a fax.

[View] menu

Show Grid : Displays the grid.

Preview : Displays the preview of the cover sheet.

Show Status Bar : Displays the status bar.

Zoom : Sets the ratio for the cover sheet editing screen.

Scale unit : Sets the scale unit of measure (cm/inch).

[Options] menu
Font : Specifies the character font.

Line Style : Specifies the line style.

Text Alignment : Adjusts the text position.

Date Format : Sets the date format.

Contact Data Fields

Sender Details
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Main Window

Main Window and Toolbar

(1) Fax No. Enter the destination fax number.

(2) Line Select Check the line type to dial the preset code before the telephone number.
See the Dialing Setting Tab of Configuration Menu.

(3) Recipient When this is entered, reflected on the cover sheet.

(4) Company When this is entered, reflected on the cover sheet.

(5) recipient(s) Indicates a number of entered station(s).

(6) Destination(s) Indicates entered destination station(s).

(7) Subject When this is entered, reflected on the cover sheet.

(8) Memo field When this is entered, reflected on the cover sheet.

(9) Cover Sheet Select various cover sheet or no cover sheet. 

(10) Attachment Indicates a number of pages attached. 

(11) Resolution Indicates a current sending resolution.

(1)

(2)

(3)
(4)

(5)

(6)

(7)

(8)

(9)
(10) (11)
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Toolbar

Used to start the transmission.

Used to view the cover sheet or transmission file.

Used to select the file to be sent.

Used to show the Send/Receive Log Manager.

Used to open your personal Phone Book.

Used to create or edit a Cover Sheet.

Used to show the On-line help.
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Configuration setting

Configuration Menu

Send Option Tab
Device Selection

• Device Name:
A device can be chosen here when more than one 
device is connected with network connected type 
devices.

• Auto Selection: 
Effective device is selected automatically by the 
priority setting order.

• Rotation:
Effective device is selected automatically in rotation 
order. (load balancing)

• Device Name: 
Only the designated device is selected.

• Status/Location/Paper Size/Resolution:
When the device is specified, the attributes of the 
device are indicated.

Page Setup
• Resolution:

Resolution to be used for the transmission.
The selectable resolutions are dependent on the 
machine's capability connected to your PC.

• Setup Quality:
Set the quality to be used for the transmission.

• Use these as the default settings:
If checked, the settings selected are used each time 
a fax is sent.

Cover Sheet Tab
Setting the usage of the Cover Sheet.

• Cover Sheet with specified fields
The address information is inserted into the TO field 
of the Cover Sheet.
The transfer time to the device sometimes becomes 
long because the image data is sent to the device 
multiple times in the case of multi-station 
transmission.

• Cover Sheet with No specified fields (Generic)
The address information is NOT inserted into the 
TO field of the Cover Sheet.
The transfer to the device is done efficiently 
because the image data is sent to the device only 
once and only the address information is sent in the 
case of multi-station transmission.
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Dialing Settings Tab
Specify the local, long distance and Inter-office call 
access numbers. These access numbers are dialed 
before the phone numbers that are registered in the 
Personal Address Book depending on the Call Type 
settings.

Sender Details Tab
Used to identify yourself with various information on the 
Cover Sheet when sending a fax.

PIN Code Tab
Specify the PIN Code settings when required by your 
telephone system.
Depending on the country, the device may not support 
this function.

Various Settings Tab
• Device Phone Book

When this box is checked, the phone book data is 
acquired from the device at the time of startup, and 
it is added into the Personal Phone Book. 
When this is used with the client & server, this 
function is effective only with the server PC
The setup of the password must be done for the 
device in the PC Fax Properties for the Network 
connected device.

• Notification Message
Various notices can be set up.
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Send/Receive Log
The transmission and the reception can be confirmed.

Send Log/Receive Log

1 Click the  button.

2 Send/Receive Log window appears.
Click Send Log and Receive Log to switch the Log 
window.
Status column

• Queuing: Send fax is queuing.
• Executing: Transferring the data to the device
• Completed: Transferring the data is completed

Result
• OK: The fax sending is completed from

 the device.
• Error Code: The fax sending is incomplete from

the device.
Note: 1 For the Network Device Version of Simple 

Send Only System with the Device Group 2 
(Please refer to the Compatible Models in 
General Description portion of this Operation 
Instruction), the Send Log shows whether 
only the transfer to the device succeeded (R-
OK). “The fax sending is completed from the 
device” can be confirmed only by the 
Communication Journal of the device.

2 For Network Device Version of the Simple 
Send Only System, the Receiving Log is not 
available.

3 For the Network Device Version of the Simple 
Send & Receive System and Local Device 
Version of Network Shared System, there is 
an Administrator Send Log that can check all 
the client(s) sending transactions. Select 
General User to see the Own Send Log and 
Administrator to see the Administrator Send 
Log. The Administrator Send Log can be 
setup with a password for security. To see the 
Administrator Send Log, Login with 
Administrator mode and check View | 
Displays All Users Send Logs. from the menu 
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Save Log
The Send/Receive Log can be saved to a separate file.
At the default setting, when the log exceeds 999 transactions it is automatically deleted from the oldest
transaction.
The log can be saved with the following steps.

Manual Save Log

1 On the Log window, select the transaction of the log
that you wish to save and click [Save Log] icon.

2 Select the Folder that you want to save and click 

.

You can make a new folder by clicking .

Note: The  button is not available on
Windows NT/98.

3 Select if you wish to Delete the Logs after saving.

4 The tiff file data (.tif) and the transmit file log
information file (.xml) are saved as a set.
The log list files (sendlog.html/recvlog.html) are made
automatically in the same folder. They can be viewed
with a Web browser (IE 5.5 or higher).

OK

New Folder

New Folder
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Send Log/Receive Log

Automatic Save Log

1 On the Log window, select Tools | Options from the
menu.

2 Option window appears.
Set the Save Log settings accordingly.
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Troubleshooting

Troubleshooting

If the printing operation fails, check the following points first:

• Connection cables are properly connected.
• Length of connection cables is not longer than 20 ft. (6 m).
• Power of devices is turned on.
• Paper is loaded on the device properly.
• Error message is not displayed on device.

The above points can be verified by printing a test page. Refer to the following for procedures for test page
printing:

NOTE 1. The status of the devices can be verified by the status monitor  (See page 101).

Printing operation fails

Windows 98/Me [General Tab]  (See page 13)

Windows NT 4.0 [General Tab]  (See page 22)

Windows 2000/XP [General Tab]  (See page 35)
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Document is not printed correctly

Problem Action
Printing position is wrong or print is
misses on the edge

Paper size or printing orientation is different between the application settings and
the printer driver settings. Specify the settings again.
The specified paper has not been loaded on the device.
Specify the settings again or load the appropriate paper.
The document margin is not sufficient. On the machine, a margin of approx. 5 mm
or more is required at the sheet edge.
(Recommended printing margin) Adjust the margin correctly.

Characters and symbols not used in
documents are printed

Verify that your machine has been selected as the printer driver.

Printing operation takes excessive
time

The wait time for printing operations depends on the spool settings.
Select Spool print jobs so program finishes printing faster in spool settings.

• Reference :
Windows 98/Me [Details Tab]  (See page 14)
Windows NT 4.0 [Scheduling Tab]  (See page 24)
Windows 2000/XP [Advanced Tab]  (See page 38)
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Error messages displayed on the computer

Problem Action
Error in writing to LPT1.
Unable to write to the Specified
device.

Verify that the device is connected to the computer correctly.
Verify that the power of the device is turned on.
Verify that the paper is properly loaded.

Error in writing to LPT1.
Printer timeout error occurred.

Verify that the power of the device is turned on.
Excessive data volume or number of pages may overflow the device's memory,
disabling data reception.
Increase the timeout setting value in properties (for transmission retry).

• Reference :
Windows 98/Me [Details Tab]  (See page 14)
Windows NT 4.0 [Port Tab]  (See page 23)
Windows 2000/XP [Port Tab]  (See page 37)

Printing is disabled due to an error in
the current printer settings.

Differences in settings such as paper size or printing orientation exists between the
application and the printer driver.
Specify the correct settings.
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Printing/Scanning Area

Top

0.1/2.5

0.1/2.5

0.1/2.5

Bottom (Unit: inches/mm)
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The printer has a parallel interface for connecting to PC.

Shape of Connector

Signal lines and pin arrangement

*Signal used for bidirectional communication

Signal functions

Parallel Interface Connector

No. I/O Signal name No. I/O Signal name 
1 I STB 19 - GND

2 I/O DATA0 20 - GND

3 I/O DATA1 21 - GND

4 I/O DATA2 22 - GND

5 I/O DATA3 23 - GND

6 I/O DATA4 24 - GND

7 I/O DATA5 25 - GND

8 I/O DATA6 26 - GND

9 I/O DATA7 27 - GND

10 O nACK 28 - GND

11 O BUSY 29 - GND

12 O PE 30 - GND

13 I SELECT 31 I nNIT

14 O nAUTOFD* 32 O nFAULT

15 - Not Used 33 - Not Used

16 - GND 34 - Not Used

17 - GND 35 - Not Used

18 O PLH 36 I nSELIN*

Signal name Function
STB Signal for sending data to printer.

Steady-state value is High. 
Printer reads data until this signal becomes from Low to High.

DATA0 to DATA7 Input signal for receiving 8-bit data.
Logic 1 is High. 
DATA0 is LSB and DATA 7 is MSB.

18 1

36 19
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Parallel Interface Connector
nACK Signal indicating that printer has read data into device completely.
This signal is output in response to /STB.

BUSY Signal indicating that printer is unable to receive data.
Printer is able to receive data when this signal is Low.

PE Signal indicating Paper Out of printer.
This signal is Low when paper is loaded and is High when paper is out.

SELECT Signal indicating that printer is under online status.
Printer is capable ofreceiving data when this signal is High.

nAUTFD Signal used for bi-directional communication

GND Ground

VCC Signal indicating that the power of printer is on.
This signal allows verifying ON/OFF status of power of printer and connection status of
printer cable.

nINT Signal for initializing printer.
Steady-state value is High.
Printer is initialized by Low.

nFAULT Signal indicating that printer is faulty.

nSELIN Signal used for bi-directional communication.

Signal name Function
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Class 2 Fax Modem Section

Installing the Panasonic Class 2 Fax Modem

The installation is required for transmitting/receiving of Faxes with a PC using general-purpose PC fax
function software (recommended: WinFax PRO 10.0).

Class 2 Fax Modem

Installation (Windows 98/Me)

1 Install the Com Port Redirector component from
the Panasonic-DMS installation using the
Custom install if you haven't installed the PDMS
software.

2 Select Settings from the Start menu and open the
Control Panel.

Double-click the Add New Hardware icon.

3 Click on the  button.Next

Continued on the next page...
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Installation (Windows 98/Me)
4

(Windows 98/Me only)

Click on the  button.

5

(Windows 98/Me only)

1. Select No, the device isn't in the list.
2. Click on the  button.

(This screen will only appear if a new device is
found.)

3. Select No, I want to select the hardware from
a list.

4. Click on the  button.

Next

Next

Next
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6 1. Select Ports (COM&LPT).
2. Click on the  button.

7 1. Select Communications Port.
2. Click the button.

8 1. Enter D:\English\PanaDMS\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

9 Click on the  button.

Next

Have Disk...

OK

Next

Continued on the next page...
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Installation (Windows 98/Me)
10 Click on the  button.

11 Click the  button.

12 Click the  button and restart the PC.

13 Repeat steps from "1" to "3."

Next

Finish

Yes
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14

(Windows 98/Me only)

1. Select No, the device isn't in the list.
2. Click on the  button.

(This screen will only appear if a new device is
found.)

3. Select No, I want to select the hardware from
a list.

4. Click on the  button.

15 1. Select Modem.
2. Click on the  button.

Next

Next

Next

Continued on the next page...
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Installation (Windows 98/Me)
16 1. Select Don't detect my modem; I will select it
from a list.

2. Click on the  button.

1. Click the button.

17 1. Enter D:\English\PanaDMS\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

18 1. Select the Class 2 Fax Modem of your
machine.

2. Click on the  button.

Next

Have Disk...

OK

Next
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19 1. Select Panasonic MFP Redirected Com Port
(COM3*).
* COM number depends on the PC.

2. Click on the  button.

20 Click the  button.

• Installation of the modem is completed.

Next

Finish
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Installing the Panasonic Class 2 Fax Modem. The installation is required for transmitting/receiving Faxes
with a PC, using general-purpose PC fax function software (recommended: WinFax PRO 10.0).

Class 2 Fax Modem

Installation (Windows NT 4.0)

1 Install the Com Port Redirector component from
the Panasonic-DMS installation using the Custom
install if you haven't installed the PDMS software.

2 Select Settings from the Start menu and open the
Control Panel.

3 Double-click Modems icon.

4 1. Select Don't detect my modem; I will select
it from a list.

2. Click on the  button.

5 Click the button.

Next

Have Disk...
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6 1. Enter D:\English\Work\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

7 1. Select the Class 2 Fax Modem of your
machine.

2. Click on the  button.

8 1. Select the COM port shown at the bottom of
the COM ports list.

2. Click on the  button.

9 Click the  button.

• Installation of the modem is completed.

OK

Next

Next

Finish

Continued on the next page...
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Installation (Windows NT 4.0)
10 Close the Modems Properties screen.
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Installing the Panasonic Class 2 Fax Modem. The installation is required for transmitting/receiving FAX's
with a PC, using a general-purpose PC fax function software (recommended: WinFax PRO 10.0).

Class 2 Fax Modem

Installation (Windows 2000/XP)

1 Install the Com Port Redirector component from
the Panasonic-DMS installation using the
Custom install if you haven't installed the PDMS
software.

2 Select Settings from the Start menu and open
the Control Panel.

3 Double-click the Add/Remove Hardware icon.

4 Click on the  button.

5 1. Select Add/Troubleshoot a device.
2. Click on the  button.

Next

Next

Continued on the next page...
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Installation (Windows 2000/XP)
6 1. Select Add a new device.
2. Click on the  button.

7 1. Select No, I want to select the hardware from
a list.

2. Click on the  button.

8 1. Select Modems.
2. Click on the  button.

9 1. Select Don't detect my modem; I will select it
from a list.

2. Click on the  button.

Next

Next

Next

Next
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10 Click the button.

11 1. Enter D:\English\PanaDMS\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

12 1. Select the Class 2 Fax Modem of your
machine.

2. Click on the  button.

13 1. Select the COM port shown at the bottom of the
COM ports list.

2. Click on the  button.

Have Disk...

OK

Next

Next

Continued on the next page...
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Installation (Windows 2000/XP)
14 1. If a warning message for logo certification
appears, click the  button and
continue installation.

2. Click the  button.
• Installation of the modem is completed.

Yes

Finish
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